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1.0 Zweck dieses Dokuments 

Dieses Dokument dient zur Vorbereitung auf den Praxisteil der Prüfung zur 
Händlerlizenz von SIX Repo AG und zugleich als Nachschlagewerk für die Benutzung 
der CO:RE-Handelsplattform. Für den theoretischen Teil der Prüfung gibt es ein 
separates Dokument. Dieses ist verfügbar unter: www.six-repo.com > Teilnehmerschaft 
> Händler > Schulung & Prüfung > Vorbereitungsunterlagen > Handel bei SIX Repo AG – 
Theorie-Unterlagen zur Prüfungsvorbereitung für Händler. 

2.0 CO:RE-Handelsplattform 

SIX Repo AG betreibt die CO:RE-Handelsplattform zur Abwicklung von Repo-
Transaktionen zur Liquiditätssicherung und Liquiditätssteuerung. Die Plattform wird 
nur einer geschlossenen Teilnehmergruppe zur Verfügung gestellt. 

Die CO:RE-Handelsplattform besteht aus zwei separaten Applikationen: 

- CO:RE Reference Data GUI 
- CO:RE Trading GUI  

Technische Informationen sind in der «Participant Section» der Homepage von SIX 
Repo AG verfügbar (www.six-repo.com, Login erforderlich). 

3.0 CO:RE Reference Data GUI 

Das CO:RE Reference Data GUI wird separat vom CO:RE Trading GUI installiert. 

Über das CO:RE Reference Data GUI sind folgende Aktionen möglich: 

- Verwaltung der Desk-Administrator-Konten 
- Verwaltung der User-Konten 
- Festlegung der Distribution List 
- Festlegung der Counterparty Agreements 

3.1 Benutzerrollen 

Folgende Benutzergruppen haben Zugriff auf das CO:RE Reference Data GUI:  

- Desk Administrator 
- Trading User 

http://www.six-repo.com/
http://www.six-repo.com/
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Benutzer Rolle Beschreibung Erstellt durch 
Desk 
Administrator 

Ermöglicht die Administration und 
Neuerfassung von Desk 
Administratoren und Trading User. 

Desk Administrator 
Wichtig: Der initiale Desk Administrator 
wird immer durch SIX Repo AG erfasst. 

Trading User Erlaubt die Erstellung und die 
Verwaltung von Distribution Lists 
und Counterparty Agreements 

Desk Administrator 

 
Hinweis: Es gibt weitere Rollen mit eingeschränkten Berechtigungen, Details dazu sind 
in der Online-Hilfe des CO:RE Reference Data GUI ersichtlich. 

Desk Administrator und Trading User haben unterschiedliche Logins, entsprechend 
unterschiedlich sieht der Starbildschirm aus. 

3.2 CO:RE Reference Data GUI – Desk Administrator 

Nach dem Login als Desk Administrator wird die folgende Startseite angezeigt: 

 

 

3.2.1 Party-Administration 

Über den Menüpunkt Party wird das Hauptfenster zur Verwaltung der Desk 
Administrators und Trading Users aufgerufen. 

- Party-Details ändern 

- Administratoren hinzufügen, ändern und entfernen 

- User (Trader) hinzufügen, ändern und entfernen 

- User zu Desks zuordnen 

- Desk-Berechtigungen aktualisieren 

- Passwörter aller Administratoren und User zurücksetzen 
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Über die Schalfläche       können neue Einträge erfasst werden (Desk Administrators 
und Users).  

Über die Schaltfläche       können bestehende Einträge bearbeitet und angepasst 
werden (Party, Desk Administrators und Users). 

Bestehende Einträge können über die Schaltfläche          gelöscht werden (Desk 
Administrators und Users). 

Wichtig: 
Neue Desks können nur von SIX Repo AG erfasst werden und nicht vom Desk 
Administrator selber. 

3.3 CO:RE Reference Data GUI – Trading User 

Nach dem Login als Trading User wird die folgende Startseite angezeigt: 
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3.3.1 Distribution Lists 

Eine Distribution List bezeichnet eine Gruppe von Repo-Teilnehmern, welche im 
bilateralen Handel als mögliche Gegenpartei adressiert werden kann. 

Über den Menüpunkt Distribution Lists wird das Hauptfenster aufgerufen, welches in 
drei Bereiche aufgeteilt ist:  

 

1. Distribution Lists 
2. Distribution List Members 
3. Distribution List Member Details 

Der Trading User kann im Bereich 1 der Distribution Lists: 

- über die Schaltfläche       eine neue Distribution List erstellen.  

- über die Schaltfläche       eine bestehende Distribution List aktualisieren und 
anpassen. 

- eine Distribution List entfernen durch Klicken auf die Schaltfläche        . 

Wichtig: 
Distribution Lists, welche im CO:RE Trading GUI zur Verfügung stehen sollen, müssen 
vorab im CO:RE Reference Data GUI konfiguriert werden. Eine Distribution List kann 
nicht direkt im CO:RE Trading GUI konfiguriert werden. 

3.3.2 Counterparty Agreements 

Die Counterparty Agreements definieren, mit welchen Parteien im CO:RE Trading GUI 
Handelsabschlüsse getätigt werden können. 

1 

2 

3 
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Über den Menüpunkt Counterparty Agreements wird das Hauptfenster aufgerufen:  

 

Es können pro Marktsegment unterschiedliche Counterparty Agreements festgelegt 
werden. Diese gelten für den Teilnehmer generell und müssen nicht  von jedem 
Trading User separat erfasst werden. 

Der Trading User kann nach Anwählen des Marktsegments mit der Schaltfläche         die 
Counterparty Agreements erfassen und bearbeiten. 

  

Counterparty Agreements müssen bilateral konfiguriert werden. In der Spalte Is Mutual 
Agreement ist ersichtlich, wenn die Gegenseite ebenfalls ein Counterparty Agreement 
erfasst hat. 

Wichtig: 
Die im CO:RE Reference Data GUI vorgenommenen Änderungen werden im CO:RE 
Trading GUI verwendet. 

Counterparty auswählen 

Counterparty entfernen 

Alle auswählen 

Alle entfernen 
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Counterparty Agreements, welche im CO:RE Trading GUI zur Verfügung stehen sollen, 
müssen vorab im CO:RE Reference Data GUI konfiguriert werden. Counterparty 
Agreements können nicht direkt im CO:RE Trading GUI konfiguriert werden. 

4.0 CO:RE Trading GUI 

Über das CO:RE Trading GUI haben die Teilnehmer Zugang zum CH-Repo-Markt und 
OTC-Spot-Markt von SIX Repo AG. Diese beinhalten auch den Zugang zu den 
Offenmarktoperationen und stehenden Fazilitäten der Schweizerischen Nationalbank 
(SNB). 

4.1 CO:RE Trading GUI einrichten 

4.1.1 Generelle Einstellungen 

Über den Menüpunkt Reference können: 

  

1 

2 

 

1. Detail-Informationen zu den im CO:RE Trading GUI verfügbaren Kontrakten und 
Wertschriften abgerufen werden. 

2. Distribution Lists und Counterparty Agreements abgefragt werden, welche im CO:RE 
Reference Data GUI definiert wurden. 

 

1 

2 
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1. Wechsel zwischen den Farbschemas «Light Color Theme» und «Dark Hi-Contrast 
Theme» 

2. Aufrufen des Preferences Menüs, wo weitere Einstellungen möglich sind, z.B. Farben 
oder Signaltöne. Details zu diesen Funktionen können der Online-Hilfe entnommen 
werden (siehe Unterkapitel 4.7 Online-Hilfe) 

4.1.2 Workspace erstellen 

Jeder Trading User kann seinen CO:RE Trading GUI mit Workspaces selber gestalten. 
Die getätigten Anpassungen werden auf dem Profil gespeichert und bleiben erhalten. 
Dabei können beliebig viele Workspaces verwendet werden. 

Ein neuer Workspace kann wie folgt erstellt werden: 

- über den Menüpunkt File > New Workspace 
- mittels rechter Maustaste im Bereich der Registerkarten  
- mit Klick auf das + im Bereich der Registerkarten 

 

 

Im darauf erscheinenden Fenster kann der Workspace erstellt und nach den eigenen 
Wünschen definiert werden. 
 

 

1. Name wählen 
2. Farbe der Registerkarte 
3. Symbol für Registerkarte 
4. Raster Layout für Workspace 

1 2 

3 

4 
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4.1.3 Workspace bearbeiten 

Ein bestehender Workspace kann durch Klick mit der rechten Maustaste auf die 
Registerkarte bearbeitet werden.  

 

Folgende Elemente können bearbeitet werden: 

- Name des Workspace 
- Farbe der Registerkarte 
- Registerkartensymbol 
- Das Workspace-Raster kann nicht bearbeitet werden. 

4.1.4 View dem Workspace hinzufügen 

Dem neu erstellten Workspace können je nach Layout eine oder mehrere Views durch 
Klick mit der rechen Maustaste hinzugefügt werden. 

Die folgenden Views stehen zur Auswahl: 
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 Zeigt tägliche Post-Trading-Aktivität an 
 
 

 Zeigt tägliche Trading-Aktivität an 
 
 

 Wird von Auktionatoren für Auktionen verwendet 
 

 Ermöglicht Teilnehmern die Teilnahme an 
Auktionen 

 

 Wird von Teilnehmern für die Teilnahme am 
bilateralen Handel verwendet 

 
 Wird für Settlement-Status und Post-Trading-

Aktivitäten verwendet 
 

 Zeigt Trade-Event-Meldungen für den laufenden 
Tag an 

 Zeigt Ausführungen für verschiedene Trading-
Modelle an 

 

 Zeigt Wechselkurse von SIX SIS an 
 
 Zeigt verfügbares Collateral und Transaktionen 

bezüglich LSFF an 
 

 Zeigt Quote-Limiten an 
 
 Zeigt Log-Meldungen an 
 
 Detaillierte Positionsübersicht des Collaterals nach 

Basket und Währung 
 

 Zusammenfassung der Positionsübersicht nach 
Währung 

 

 Zeigt öffentliche Geschäfte an 
 
 Ermöglicht Quoting im angegebenen Bereich 
 
 Ermöglicht Quoting im angegebenen Bereich 
 
 Zeigt definierte RSS-Feeds an 
 
 Öffnet integrierten Webbrowser 
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4.1.5 Grösse der Views ändern 

Die Views eines Workspace können einzeln mittels der Zoom-Einstellungen in der 
Titelleiste der einzelnen View angepasst werden. 

 

Zur gleichzeitigen Anpassung aller Views eines Workspace kann der Schieberegler am 
unteren Fensterrand verwendet werden. 

 

4.1.6 Spalten anordnen und filtern 

4.1.6.1 Spalten anzeigen 

Über das kleine + in der Kopfzeile der Tabellenspalten können einzelne Spalten 
ausgeblendet oder zusätzliche Spalten eingeblendet werden. 

 

4.1.6.2 Spalten anordnen und sortieren 

In allen Ansichten kann die Reihenfolge der Spalten individuell durch Drag & Drop mit 
der Maus angepasst werden. 

Durch Klicken auf die Überschrift wird diese Spalte sortiert. Ein kleiner Pfeil zeigt an, ob 
die Sortierung aufsteigend ober absteigend erfolgt.  

4.1.6.3 Spalten Filtern 

Für jede Spalte können durch Klicken mit der rechten Maustaste auf die Überschrift 
verschiedene Filteroptionen ausgewählt werden. 
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4.1.7 Master Filter 

Der Master Filter definiert Einstellungen, welche über alle Workspaces Gültigkeit haben. 
Die Konfiguration erfolgt über den Menüpunkt View > Configure Master Filter. 

Als Standardeinstellung sind alle Währungen, Laufzeiten (Terms) und Baskets für die 
Anzeige im Workspace markiert. 
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Einträge können einzeln mittels Häkchen ergänzt oder entfernt werden.  

Die Schaltfläche  entfernt alle Einträge.  

Die Schaltfläche  ergänzt alle Einträge. 

Standardmässig ist der Master Filter aktiviert, was erkennbar ist am umrahmten 
Symbol         im Workspace. 

Durch Klicken auf das Symbol wird der Master Filter für den jeweiligen Workspace 
deaktiviert bzw. wieder aktiviert.  

4.1.8 Limit Projection View 

Die Limit Projection View erlaubt es, auf der Basis von Party, Currency, Term, Amount 
und Buy/Sell-Indikator Quoting Limits für die Handelsparteien zu konfigurieren. Es wird 
empfohlen, die Limiten nur auf Ebene Party zu setzen.  

Limits sind ausschliesslich auf Quotes anwendbar und ermöglichen die automatische 
Trade-Erstellung innerhalb der Limits. Die Konfiguration der Limits erfolgt über einen 
Workspace mit dem View «Limit Projection View».  

Nach Anwählen des Marktsegments können die Limiten über die Schaltfläche  
                            erfasst bzw. angepasst werden.  

 

Bei der erstmaligen Konfiguration muss die Struktur definiert werden, bis auf welche 
Ebene die Limiten angezeigt werden sollen. Über die Schaltfläche                             wird 
der Dialog gestartet. 
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Im nachfolgenden Fenster können die Attribute ausgewählt werden. 

 

Es wird empfohlen, die Limiten nur auf Ebene Party zu setzen und entsprechend nur 
diesen Punkt auszuwählen.  

Nach Abschluss der Konfiguration stehen die Felder zur Definition der Limite zur 
Verfügung. 

Item auswählen 

Item entfernen 

Alle auswählen 

Alle entfernen 
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Es können die Party und die jeweilige Limit erfasst werden. Die Eingabe muss mit         
bestätigt werden.  

Wichtig: die Overall Limit muss auch erfasst werden, diese muss mindestens dem Total 
aller Limits entsprechen. 

Wenn alle Limits erfasst sind, wird der Vorgang durch Klicken auf                 
abgeschlossen. 

In der Limit Projection View werden alle konfigurierten Limits des angewählten 
Marktsegments angezeigt. 

 

Die Limit Projection View zeigt die verfügbaren Auto-match Limits und die Benutzung 
der Limits über eine Periode von 5 Tagen. Standardmässig wird nur die Spalte Total 
angezeigt. Über den Menüpunkt Value Columns können weitere Spalten eingeblendet 
werden. 
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Die einzelnen Spalten zeigen dabei folgende Werte an: 

Pending 
Quoting-Transaktionen, die Ihre Quoting-Limits mit einer bestimmten Gegenpartei 
verletzt haben und manuell akzeptiert werden müssen 

Executed 
Heute abgewickelte Quoting-Transaktionen (inklusive Transaktionen, die anhand der 
von Ihnen festgelegten Limits abgeglichen wurden)  

Inventory  
Transaktionen, die via SECOM abgewickelt wurden (ohne heutige Transaktionen) 

Total 
Insgesamt ausstehendes Volumen (Executed und Inventory) 

4.2 Quoting 

Ein Quote ist eine generelle, unverbindliche Offerte zum Kauf oder Verkauf von 
Collateral zu einem angebotenen Preis.  

4.2.1 Workspace einrichten 

Es muss ein Workspace mit einer der gewünschten Quoting Views erstellt werden. 

 

In der View müssen anschliessend im Bereich Market Overview durch Klicken auf das 
Symbol       die gewünschten Contracts hinzugefügt werden. 
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Eine bestehende Auswahl kann auf die gleiche Weise angepasst werden. Die neu 
ausgewählten Contracts können:  

- der bestehenden Auswahl hinzugefügt werden 

- die bestehende Auswahl ersetzen 

- Die ausgewählten Contracts werden in den Bereich Market Overview übernommen. 
Zur besseren Übersicht können mit der Schaltfläche        Contracts ohne Quotes 
ausgeblendet werden. 

 

Die Spalten der Anzeige können durch Klicken auf das kleine + angepasst werden. Es 
können z.B. die Spalten Own Buy Status/Own Sell Status eingeblendet werden, um die 
eigenen Quotes am Markt mit denen der anderen Teilnehmer zu vergleichen.  

Die Reihenfolge der Spalten kann per Drag & Drop angepasst werden. 

- Spalten können 
sortiert werden 
 

- Mehrfach-Auswahl 
durch gedrückte 
„ctrl“ Taste 
 

- Von/bis Auswahl mit 
gedrückter  
Umschalt Taste 
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4.2.2 Quotes erfassen 

Im Bereich Own Quotes unter Market Overview können durch Doppelklick auf die Felder 
Own Buy oder Own Sell sowie Buy Quantity oder Sell Quantity die Details für den eigenen 
Quote erfasst werden. 

 

Die so erfassten Quotes müssen noch am Markt veröffentlicht werden. Dies erfolgt 
entweder durch Klicken der rechten Maustaste auf den Quote und dann mit Publish 
Selected Quotes oder durch Klicken auf das entsprechende Symbol in der Menüleiste.  

 

Nun kann der Quote von allen Parteien in der Market Overview eingesehen werden. 

4.2.3 Quotes anpassen 

Bestehende Quotes können angepasst werden. Dazu muss im Bereich Quote Details 
der betreffende Quote mit der rechten Maustaste angeklickt und dann der Menüpunkt 
Amend Quote ausgewählt werden.  
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Alternativ kann auch das Symbol       in der Menüleiste angewählt werden, wenn der 
Quote im Bereich Quote Details markiert ist. 

In der daraufhin angezeigten Maske können die Änderungen vorgenommen und durch 
Klicken auf die Schaltfläche Send bestätigt werden. 

 

4.2.4 Quote beantworten 

Quotes für die gleiche Währung (CCY), den gleichen Basket (Asset) und die gleiche 
Laufzeit (Term) werden in derselben Zeile in der Market Overview ausgewiesen. 
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Die Markttiefe wird im Fenster Quote Details angezeigt. Hier sind die Details der 
einzelnen Quotes ersichtlich, und es kann ein Order auf einen Quote erfasst werden. 

 

Der Bereich Quote Details ist unterteilt in Buy (links) und Sell (rechts).  

Um auf einen Quote eines anderen Teilnehmers zu reagieren, muss im Market 
Overview der gewünschte Term ausgewählt werden. Im Bereich Quote Details kann 
durch Klicken mit der rechten Maustaste auf den gewünschten Quote und Auswahl des 
Menupunktes Respond to Quote with Sell Order bzw. Buy Order das entsprechende 
Fenster aufgerufen werden. 

 

Alternativ kann auch das Symbol  in der Menüleiste angewählt werden, wenn der 
Quote im Bereich Quote Details markiert ist. 
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Durch die Erfassung von Repo Orders wird ein verbindliches Angebot zum Abschluss 
eines Geschäfts an die Gegenpartei übermittelt. 

Die erfassten Orders werden im Bereich Orders in der Quoting View angezeigt. 

 

4.2.5 Antworten auf Orders zu eigenen Quotes 

Wenn eine Gegenpartei einen Order auf einen eigenen Quote übermittelt, erscheint 
dieser ebenfalls im Bereich Orders.  

Durch Klicken mit der rechten Maustaste öffnet sich das Kontextmenü mit folgenden 
Optionen: 

- Take Order 
- Reject Order 
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Alternativ kann auch das entsprechende Symbol in der Menüleiste angewählt werden, 
wenn der Order im Bereich Orders markiert ist.  

4.2.5.1 Auto Match 

Wenn für eine bestimmte Gegenpartei in der Limit Projection View (siehe Unterkapitel 
4.1.8 Limit Projection View) eine Auto Match Limite konfiguriert wurde und ein Quote zu 
einem Abschluss führt, kommt das Limit Management zur Anwendung: 

- Wird die Limite der Gegenpartei nicht verletzt, wird der Order automatisch 
abgeglichen. 

- Wird die Limite verletzt (Limit Breach), muss der Order manuell akzeptiert werden, 
um einen Trade zu erstellen. 

In der Spalte Auto Match im Bereich Orders ist ersichtlich, ob die Auto Match-Funktion 
zur Anwendung kam.  

 

4.2.6 Quotes löschen 

Einzelne Quotes können im Bereich Quote Details durch Klicken mit der rechten 
Maustaste auf den betreffenden Quote und mit Auswahl des Punktes Cancel Selected 
Quote gelöscht werden. 
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Alternativ kann auch das Symbol  in der Menüleiste angewählt werden, wenn der 
Quote im Bereich Quote Details markiert ist.  

Sollen mehrere Quotes gelöscht werden, stehen folgende Optionen zur Verfügung: 

 

a. Alle Quotes eines Terms löschen 
Rechtsklick auf den betroffenen Term und den Menüpunkt Cancel All Quotes for 
Selected Rows auswählen. 

b. Alle Quotes eines Marktsegments löschen 
Rechtsklick auf einem beliebigen Term des betroffenen Marktsegments und 
denMenüpunkt Cancel All Quotes on Selected Market Segment auswählen 

b 

a 
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4.3 Bilateral Trading 

Das Bilateral Trading ermöglicht den Handel im Repo-Markt und im OTC Spot Markt mit 
bestimmten Gegenparteien. 

4.3.1 Workspace einrichten 

Es muss ein Workspace mit der Bilateral Trading View erstellt werden. Diese View ist 
unterteilt in die Bereiche Initiation und Negotiation. Es werden sowohl der OTC-Spot-
Markt als auch der Repo-Markt angezeigt. 

 

Im Bereich Initiation werden Orders und Offers gesendet. Zudem ist ersichtlich, welche 
Aufträge erteilt oder erhalten wurden und welchen Status sie jeweils haben. 

Im Bereich Negotiation werden Orders und Offers ausgehandelt und abgeschlossen. 
Die Details im Bereich Negotiation beziehen sich auf Offers und Orders, die im Bereich 
Initiation gewählt wurden. 

Wichtig: 
Ein Trade ist nur mit einer Gegenpartei möglich, für die vorgängig ein Counterparty 
Agreement im CO:RE Reference Data GUI erfasst wurde. 

4.3.2 Repo Request Offer 

Ein Request Offer stellt eine Handelsaufforderung an eine qualifizierte Gruppe von 
Empfängern (definiert durch eine Distribution List) oder eine bestimmte Gegenpartei 
dar. Die Standardeinstellung ist All Parties und umfasst alle Gegenparteien, mit denen 
ein Counterparty Agreement besteht. 

Initiation 

Negotiation 
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4.3.2.1 Neuer Repo Request Offer erfassen 

Das Fenster zur Erfassung eines neuen Repo Request Offer wird durch Klicken der 
rechten Maustaste im Bereich Initiation und dann mit New Repo Request Offer oder 
durch Klicken auf das entsprechende Symbol in der Menüleiste aufgerufen. 

 

Im Fenster für die Erfassung des Repo Request Offer sind folgende Eingaben zwingend 
erforderlich: 

- Currency 
- Term 
- Basket 
- Distribution List oder Counterparty 
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Die restlichen Felder sind optional und können zur weiteren Parametrisierung des 
Geschäftes verwendet werden. Gewisse Werte werden jedoch automatisch vom System 
abgefüllt, abhängig vom gehandelten Instrument (Traded Instrument). 

4.3.2.2 Repo Request Offer aushandeln 

Eingehende Repo Request Offers von anderen Parteien werden im Bereich Initiation der 
Bilateral Trading View angezeigt.  

Um einen Request Offer zu beantworten, wird durch Klicken mit der rechten Maustaste 
auf den betreffenden Eintrag das entsprechende Kontextmenü geöffnet. 
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Es gibt folgende Möglichkeiten: 

a. Order Response to Request Offer 

Die Request Offer wird mit einem Order an die Gegenpartei beantwortet, d.h. es erfolgt 
eine verbindliche Adressed Offer. 

Alternativ kann auch das Symbol       in der Menüleiste angewählt werden.  

Im Fenster Repo Order Response to Request Offer können die Attribute, welche von der 
Gegenpartei nicht erfasst wurden, ergänzt und die folgenden Werte noch angepasst 
werden, bevor der Order übermittelt wird: 

- Repo Rate 
- Cash Amount 
- Minimal Size 
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b. Quote Response to Request Offer 

Die Request Offer wird mit einem Quote an die Gegenpartei beantwortet, d.h. es wird 
eine angepasster Quote an die Gegenpartei retourniert. 

Alternativ kann auch das Symbol       in der Menüleiste angewählt werden.  

Im Fenster Repo Quote Response to Request Offer können die folgenden Attribute noch 
angepasst werden, bevor der Quote übermittelt wird: 

- Repo Rate 
- Quantity 
- Minimal Size 
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Nach der Beantwortung der Request Offer wechselt der Status im Bereich Initiation der 
Bilateral Trading View auf Replied (Order Response) bzw. Countered (Quote Response) 
Die Details sind im Bereich Negotiation ersichtlich. Dazu muss der betreffende Offer im 
Bereich Initiation angewählt sein.  

 

Ein Order Response muss von der Gegenpartei noch mittels Take Order akzeptiert 
werden, damit der Trade zustande kommt. Sie kann diesen aber auch ablehnen. 
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Eine Quote Response muss von der Gegenpartei wiederum mit einer Order Response 
beantwortet werden. 

4.3.3 Repo Order 

Ein Repo Order ist eine Addressed Offer, ein verbindliches Angebot zum Abschluss 
eines Geschäfts an eine einzelne ausgewählte Gegenpartei. Es kommt keine 
Distribution List zur Anwendung. 

4.3.3.1 Neuer Repo Order erfassen 

Das Fenster zur Erfassung eines neuen Repo Order wird durch Klicken der rechten 
Maustaste im Bereich Initiation und dann mit New Repo Order oder durch Klicken auf 
das entsprechende Symbol in der Menüleiste aufgerufen. 

 

Im Fenster für die Erfassung des Repo Order sind folgende Eingaben zwingend 
erforderlich: 

- Market Segment 
- Buy/Sell 
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- Currency 
- Term 
- Basket 
- Traded Amount 
- Counterparty 

 

Die restlichen Felder sind optional und können zur weiteren Parametrisierung des 
Geschäftes verwendet werden.  

4.3.3.2 Erhaltener Repo Order akzeptieren 

Eingehende Repo Orders von anderen Parteien werden im Bereich Initiation der 
Bilateral Trading View angezeigt. Wenn ein Repo Order angewählt wird, sind die Detail 
im Bereich Negotiation ersichtlich. 

 

Um einen Repo Order zu beantworten, wird 
durch Klicken mit der rechten Maustaste auf 
den betreffenden Eintrag im Bereich Negotiation 
das entsprechende Kontextmenus geöffnet. 
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Für einen erhaltenen Repo Order stehen folgende Optionen zur Verfügung: 

Counter Order 
Der Order wird mit Anpassungen akzeptiert  

Take Order 
Order wird akzeptiert 

Reject Order 
Der Order wird abgelehnt 

 

 

Die Optionen können alternativ auch über das jeweilige Symbol in der Menüleiste 
ausgewählt werden, wenn der Auftrag markiert ist. 

Wenn ein Repo Order mit einem Counter Order beantwortet wird, muss die 
Gegenpartei diesen wiederum mit einer Take-Order-Meldung beantworten. 

Repo Orders, welche von einer Seite mittels Take Order akzeptiert wurden, erscheinen 
umgehend mit dem Status ENDED im Bereich Initiation bzw. FULLY MATCHED im 
Bereich Negotiation. 
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4.3.4 Templates 

Zur Vereinfachung der Eingabe einer Offer oder eines Order können Templates erstellt 
werden. Dazu kann nach Eingabe der relevanten Felder im jeweiligen Erfassungsfenster 
auf das grüne + am unteren Rand geklickt werden. 

 

Nach Eingabe eines Namens und einer Tastenkombination wird das Template erstellt. 
Dieses kann bei der Erfassung einer neuen Offer bzw. eines neuen Orders entweder 
mit der Tastenkombination oder durch Auswahl im Dropdown-Menu und klicken der 
Schaltfläche         abgerufen werden. 

4.3.5 Conversation History 

Um alle ein- und ausgehenden Meldungen eines bilateralen Handels anzuzeigen, kann 
mit der rechten Maustaste der jeweiligen Auftrag im Bereich Negotiation angeklickt und 
im Kontext Menu das Symbol für Show Conversation History angewählt werden. 

  

Alternativ kann das Symbol         in der Menu Leiste angeklickt werden, wenn der 
betreffende Auftrag im Negotiation Bereich markiert ist.  
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4.4 Executions View 

Alle eigenen Geschäfte, welche am aktuellen Tag abgeschlossen wurden, sind in der 
Executions View ersichtlich. 

 

4.4.1 Trade Slip anzeigen 

Um den Trade Slip eines Geschäfts anzuzeigen, kann mit der rechten Maustaste der 
jeweiligen Auftrag angeklickt und im Kontext Menu das Symbol für Market Trade Slip 
ausgewählt werden. 

 

Alternativ kann das Symbol        in der Menu Leiste angeklickt werden, wenn der 
betreffende Auftrag markiert ist.  

4.5 Auctions Overview 

Die Auctions Overview zeigt alle Auktionen an, an welchen der Teilnehmer teilnehmen 
kann. 
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4.5.1 Teilnahme an einer Auktion 

Um an einer Auktion teilzunehmen, kann durch klicken mit der rechten Maustasche auf 
die Auktion der Punkt Send Auction Order ausgewählt werden. Optional kann auch in 
der Menu Zeile das Symbol        ausgewählt werden. 

 

Im Fenster New OTC SPOT Auction Order muss der Teilnehmer den Preis und die 
Anzahl (Security Size) eingeben (wenn der Auktionator keinen Wert eingegeben hat) 
oder nur die Anzahl, wenn der Auktionator den Preis vorgegeben hat. 
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Die vom Teilnehmer erfassten Auction Orders werden in der Auction Overview View 
unter Own Orders angezeigt. 

 

4.5.2 Auction Order löschen 

Der Teilnehmer kann Orders löschen, solange diese den Status «Initiated» haben. Die 
Löschung erfolgt durch klicken mit der rechten Maustaste auf den Order und dann auf 
die Option Cancel Order. 
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Alternativ kann das entsprechende Symbol in der Menu Leiste im Bereich Own Orders 
angewählt werden, wenn der Order markiert ist. 

4.6 Contract Inventory 

Die Ansicht Contract Inventory zeigt den aktuellen Status der abgeschlossenen Repo 
Trades. Es können auch Geschäfte modifiziert oder annulliert werden. 

Repo Trades, welche nach erfolgtem Rückkauf den Status «Closed» erreichen, werden 
in der Ansicht Contract Inventory nicht mehr angezeigt. Es ist keine Trade History 
verfügbar, diese kann via Reports bei SIX Repo AG aufgesetzt und bezogen werden.  

4.7 Online Hilfe 

Im Rahmen dieses Dokuments werden nur die wichtigsten Views und Funktionen 
beschrieben. Für weitere Informationen steht die Online Hilfe zur Verfügung. Diese 
kann in jeder Ansicht über das Hilfe Symobl aufgerufen werden. 

 

Alternativ ist die Online Hilfe auch über den Menu Punkt Help > Online Help erreichbar. 
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